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1 zzzPAT-ohjelmiston esittely 
Huomautus: Tässä asiakirjassa sanoilla WatchPAT™, WatchPAT ja WP viitataan kaikkiin 
neljään laitteeseen (WP200, WP200U, WP300 ja WP-ONE [WP1]), ellei toisin ole mainittu. 

Tarkemmat ohjeet kuvineen löytyvät Itamar-Medicalin verkkosivustolta 
(https://www.itamar-medical.com/support/downloads/) 

1.1 Watch-PAT200-laitteen käyttötarkoitus/käyttöaiheet 

Watch-PAT200 (WP200) on ei-invasiivinen kotihoitolaite, jota käytetään potilaille, joilla 
epäillään olevan unen aikaisia hengityshäiriöitä. Laitetta voidaan käyttää apuna unen 
aikaisten hengityshäiriöiden havaitsemisessa ja diagnosoinnissa sekä eri univaiheiden 
(REM-uni, kevyt uni ja syvä uni) tunnistamisessa. Laite laskee perifeerisen arteriaalisen 
tonometrian (PAT), hengityshäiriöindeksin (pRDI), apnea-hypopneaindeksin (PAHI) ja 
univaiheiden PAT-tunnistuksen (PSTAGES) sekä valinnaisesti kuorsauksen tason ja 
vartalon asennon ulkoisen integroidun kuorsausta ja vartalon asentoa mittaavan anturin 
(SBP) avulla. Laite saa toiminnoista PSTAGES ja SBP lisätietoa PRDI-/PAHI-
määrityksiin. Laitteen toimintoja PSTAGES ja SBP ei ole tarkoitettu käytettäväksi ainoana 
tai pääasiallisena perusteena unen aikaisten hengityshäiriöiden diagnosoinnissa, 
hoitomääräyksissä tai sen määrittämisessä, onko muu diagnostinen arviointi perusteltua. 

WP200-laitetta ei ole tarkoitettu käytettäväksi alle 17-vuotiaille lapsille. 

1.2 Watch-PAT200U- ja WP300-laitteiden käyttötarkoitus/käyttöaiheet 

Watch-PAT200U (WP200U) ja Watch-PAT300 (WP300) ovat ei-invasiivisia 
kotihoitolaitteita, joita käytetään potilaille, joilla epäillään olevan unen aikaisia 
hengityshäiriöitä. WP200U- ja WP300-laitteita voidaan käyttää apuna unen aikaisten 
hengityshäiriöiden, eri univaiheiden (REM-uni, kevyt uni, syvä uni ja hereillä olo) sekä 
kuorsauksen tason ja vartalon asennon havaitsemisessa. Laite laskee perifeerisen 
arteriaalisen tonometrian (PAT), hengityshäiriöindeksin (pRDI), apnea-hypopneaindeksin 
(PAHI), apnea-hypopnean keski-indeksin (PAHIc) ja univaiheiden PAT-tunnistuksen 
(PSTAGES) sekä valinnaisesti kuorsauksen tason ja vartalon asennon ulkoisen 
integroidun kuorsaus- ja vartalon asentoanturin avulla. Laite saa toiminnoista PSTAGES, 
kuorsauksen taso ja vartalon asento lisätietoa PRDI-/PAHI-/PAHIc-määrityksiin. Laitteen 
toimintoja PSTAGES, kuorsauksen taso ja vartalon asento ei ole tarkoitettu käytettäväksi 
ainoana tai pääasiallisena perusteena unen aikaisten hengityshäiriöiden diagnosoinnissa, 
hoitomääräyksissä tai sen määrittämisessä, onko muu diagnostinen arviointi perusteltua. 

PAHIc on tarkoitettu käytettäväksi vähintään 17-vuotiaille potilaille. Kaikkia muita 
toimintoja voidaan käyttää vähintään 12-vuotiaille potilaille. 

Huomautus: pAHIc-arvo käy ilmi raportista, mikäli sääntelyviranomaiset ovat sen 
kyseisessä maassa hyväksyneet 
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1.3 WatchPAT™ONE (WP1) -laitteen käyttötarkoitus/käyttöaiheet 

WatchPAT™ONE (WP1) -laite on ei-invasiivinen kotihoitolaite, jota käytetään potilaille, 
joilla epäillään olevan unen aikaisia hengityshäiriöitä. WP1-laitetta voidaan käyttää apuna 
unen aikaisten hengityshäiriöiden havaitsemisessa ja diagnosoinnissa sekä eri 
univaiheiden (REM-uni, kevyt uni, syvä uni ja hereillä olo) tunnistamisessa. WP1 laskee 
perifeerisen arteriaalisen tonometrian (PAT) avulla hengityshäiriöindeksin (PRDI) ja 
apnea-hypopneaindeksin (PAHI) ja tunnistaa univaiheet (PSTAGES). 

WatchPAT™ONE on saatavana rinta-anturilla tai ilman. Rinta-anturin avulla voidaan 
määrittää kuorsauksen taso, vartalon asento ja apnea-hypopnean keski-indeksi (PAHIc). 

WP1-laite saa toiminnoista PSTAGES, kuorsauksen taso ja vartalon asento lisätietoa 
PRDI-/PAHI-/PAHIc-määrityksiin. WP1-laitteen toimintoja PSTAGES, kuorsauksen taso 
ja vartalon asento ei ole tarkoitettu käytettäväksi ainoana tai pääasiallisena perusteena 
unen aikaisten hengityshäiriöiden diagnosoinnissa, hoitomääräyksissä tai sen 
määrittämisessä, onko muu diagnostinen arviointi perusteltua. 

PAHIc on tarkoitettu käytettäväksi vähintään 17-vuotiaille potilaille. Kaikkia muita 
toimintoja voidaan käyttää vähintään 12-vuotiaille potilaille. 

1.4 zzzPAT-ohjelmiston määritelmä 

zzzPAT on WP-laitteiden kanssa käytettävä analyysiohjelmistopakkaus, joka tukee unen 
aikaisten hengityshäiriöiden diagnosoinnissa, havaitsee unen eri vaiheet (REM, kevyt uni, 
syvä uni ja hereillä olo) sekä mittaa kuorsauksen voimakkuuden ja vartalon asennon. 
zzzPAT-ohjelmisto näyttää WP-laitteiden tallentamat signaalit, tunnistaa 
hengityshäiriötapahtumat, unen eri vaiheet sekä kuorsauksen ja vartalon asentotiedot. 
Lisäksi se luo kattavan raportin lääkäriä varten. 

1.5 Yleiskuvaus 

zzzPAT-algoritmit käyttävät neljää WP-kanavaa: PAT, syke, aktigrafi ja happisaturaatio 
(joko WP200-laitteen tallentamana tai WP200U-/WP300-/WP1-laitteesta saatuna). Niiden 
avulla havaitaan unen aikaiset hengityshäiriöt ja unen eri vaiheet (REM, kevyt uni, syvä 
uni ja hereillä olo). WP200U-, WP300- ja WP1-laitteissa sentraalisen uniapnean 
tunnistamista helpottaa, että RESBP-anturin muiden WP-kanavien lisäksi käytetään 
hengitysliikkeiden kanavaa. 

zzzPAT käyttää WP-laitteen kuorsaus- ja asentokanavia kuorsauksen tason ja vartalon 
asennon tilojen määritykseen. Ohjelmisto tuottaa tutkimuksen pohjalta kattavia raportteja, 
joihin sisältyy tilastoja ja tulosten graafinen esitys. Koko yön aikaiset tiedot ovat 
näytettävissä, ja automaattisesti havaitut tapahtumat ovat tarkasteltavissa manuaalisesti. 

Huomautus: Tässä asiakirjassa kuorsausta ja vartalon asentoa mittaavalla anturilla 
viitataan sekä SBP-anturiin että RESBP-anturiin, ellei toisin ole mainittu. WP200(U)-
/WP300-laitteessa kuorsausta ja vartalon asentoa mittaavan anturin käyttö on 
vapaaehtoista ja tapahtuu lääkärin suositusten mukaisesti. RESBP-anturia voi käyttää, 
mikäli sääntelyviranomaiset ovat sen kyseisessä maassa hyväksyneet. 

Käyttöoppaassa on tarvittavat tiedot zzzPAT-ohjelmiston rutiinikäyttöön. 
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Rajoitukset 

WP-järjestelmien tarjoamat havainnot ja laskelmat on tarkoitettu apuvälineiksi unen 
aikaisten hengityshäiriöiden diagnostiikassa. Niitä ei nimenomaisesti ole tarkoitettu ainoaksi 
ehdottomaksi perustaksi kliiniselle diagnoosille. 

 zzzPAT-ohjelmistoa saa käyttää vain yhteensopivissa tietokoneissa, jotka 
täyttävät tässä asiakirjassa määritetyt vaatimukset. 

 Muiden ohjelmien, joko kaupallisesti saatavana olevien tai mukautettujen, 
suorittaminen samanaikaisesti zzzPAT-ohjelmiston kanssa saattaa häiritä sen 
toimintaa. 

 Uni- ja lepotilaominaisuudet on poistettava käytöstä, jos käytössä on jaettu 
tietokanta. 
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2 Asentaminen 
2.1 zzzPAT-ohjelmiston yleiskuvaus 

zzzPAT on patentoitu tietokoneohjelmisto, joka on kehitetty nimenomaisesti WP-laitteen 
tallentamien tietojen hallintaan ja analysointiin. Ohjelmisto esittää ja tallentaa kerätyt 
signaalit, ja sen analyysitoiminnoilla voi tulkita tietoja. 

WP200(U)-/WP300-laitteessa WP-laitteen sisäiseen muistikorttiin tallentamat tiedot 
luetaan USB-kaapelin avulla. zzzPAT-ohjelmisto tunnistaa automaattisesti sisäisessä 
muistikortissa olevat tiedot, kun WP yhdistetään tietokoneeseen USB-
tiedonsiirtokaapelilla. 

WP1-laitteessa internetyhteyttä käytetään laitteen tallentamien tietojen lukemiseen. 
zzzPAT-ohjelmisto avaa automaattisesti luettelon kaikista rekisteröidyistä potilaista, 
joiden tutkimusta ei vielä ole haettu verkkopalvelimelta. 

Lisätietoja tarvittavasta tietokonekokoonpanosta on kohdassa 0. 

zzzPAT-ohjelmistoa voi käyttää kahdessa tilassa: 

Erilliskäyttö – käytetään yksittäisessä tietokoneessa paikallisen tietokannan kanssa. 

Jaettu käyttö – käytetään verkkoympäristössä, jossa useista zzzPAT-työasemista on 
yhteys yhteen, jaettuun tietokantaan. 

 

Ahuomautus 

On erittäin suositeltavaa koordinoida zzzPAT-ohjelmiston 
jaetun käyttötilan määrittäminen Itamar Medical -edustajan 
kanssa. Asianmukainen käyttö edellyttää lisäkoulutusta. 

zzzPAT-käyttötila määritetään asennuksen aikana, kuten kattavan kuvitetun oppaan 
asennusta käsittelevässä kohdassa kerrotaan. 
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3 zzzPAT-kokoonpanon määrittäminen 
3.1 Asetukset>Hakemistot 

Tuo esiin zzzPAT-työhakemiston, tällä hetkellä yhdistettynä olevan tietokannan nimen, 
tiedostohakemiston (signaalitiedostojen tiedot) ja USB-aseman. 

Näet jaettuun tietokantaan yhteydessä olevat käyttäjät valitsemalla DB Logged Users 
(Tietokantaan kirjautuneet käyttäjät). 

Luettelossa ovat kaikkien niiden tietokoneiden nimet, jotka käyttävät samaa jaettua 
tietokantaa ja joissa zzzPAT-sovellus on käynnissä. 

3.2 Asetukset>Käyttäjäasetukset  

Käyttäjä voi muuttaa seuraavia määritysparametreja avaamalla User Settings 
(Käyttäjäasetukset) -valintaikkunan kohdassa Setup>User Settings 
(Asetukset>Käyttäjäasetukset). Jokaisen käyttäjän User Settings (Käyttäjäasetukset) -
määritysparametrit tallentuvat zzzPAT-tietokantaan (erillisasennuksessa paikalliseen 
tietokantaan ja jaetussa asennuksessa jaettuun tietokantaan). 

 

Ahuomautus 

Kun jaetussa käyttötilassa käyttäjiä kirjautuu sisään useista 
zzzPAT-työasemista samanaikaisesti, kaikki zzzPAT-
ohjelmiston käyttäjäasetusten muutokset eivät välttämättä 
tallennu zzzPAT-istunnon päätyttyä. 

Kun kaikki muutokset asetuksiin on tehty, sulje Settings (Asetukset) -valintaikkuna 
valitsemalla OK. 

Lisätietoja on kattavassa kuvitetussa oppaassa. 

3.3 Asetukset>Yleiset asetukset 

Vain käyttäjä, jolla on User Administration (Käyttäjähallinta) -oikeudet, voi muuttaa 
seuraavia määritysparametreja avaamalla General Settings (Yleiset asetukset) -
valintaikkunan kohdassa Setup>General Settings (Asetukset>Yleiset asetukset). 
Yleiset asetukset tallentuvat zzzPAT-tietokantaan (erillisasennuksessa paikalliseen 
tietokantaan ja jaetussa asennuksessa jaettuun tietokantaan). 

Nämä asetukset koskevat koko järjestelmää. Mukautetut asetukset ovat kaikkien 
käyttäjien saatavilla. 

Kun kaikki muutokset asetuksiin on tehty, sulje General Settings (Yleiset asetukset) -
valintaikkuna valitsemalla OK. 

Lisätietoja on kattavassa kuvitetussa oppaassa. 
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4 zzzPAT-ohjelmiston käyttäminen 
4.1 Uuden tutkimuksen valmisteleminen 

Potilastiedoston valmisteleminen on välttämätön osaWP-laitteiden valmistelua 
unitutkimukseen. 

4.1.1 zzzPAT-ohjelmiston käynnistäminen 

 Käynnistä zzzPAT (zzzPAT-tietokannan ohjattu asennustoiminto) 

napsauttamalla työpöydällä olevaa zzzPAT-kuvaketta . 

 Kun zzzPAT-kuvaketta  napsautetaan, esiin tulee 
sisäänkirjautumisikkuna: 

 Anna Login (Käyttäjätunnus) ja Password (Salasana). Kun jaettu käyttötila on 
asennettu, käyttäjä voi sisäänkirjautumisnäytössä valita, mihin tietokantaan 
zzzPAT muodostaa yhteyden. 

 Sisäänkirjautumisikkunassa on kaksi eri kirjautumisvaihtoehtoa: 

o Active Directory (nykyinen toimialueen palvelin). 

o zzzPAT-tietokannan käyttäjät 

 Valitse haluttu tietokanta, johon haluat yhteyden muodostaa (soveltuvin osin). 

 Anna käyttäjätunnus ja salasana ja jatka valitsemalla OK. 

4.1.2 Uuden tutkimuksen valmisteleminen 

Esiin tulee New study (Uusi tutkimus) -ikkuna, jossa on oletuslaitetyypin 
(WP200(U)/WP300/WP-ONE) ja kokoonpanon mukaiset kentät 

 Uuden tutkimuksen valmisteleminen (WP200(U)/WP300) 

 Varmista, että laite on yhdistetty tietokoneeseen ja zzzPAT-ohjelmistoon USB-
kaapelilla. 

 Valitse zzzPAT-ohjelmistosta File>New Study Details (Tiedosto>Uuden 
tutkimuksen tiedot) tai napsauta työkalurivin New Study (Uusi tutkimus) -

kuvaketta . 

 Esiin tulee New Study (Uusi tutkimus) -valintaikkuna. 

 Lisää pakollinen potilastunnus Patient (Potilas) -kenttiin. 

 Lisää muita tietoja tarvittaessa. Muut kentät ovat vapaaehtoisia. 

 Valitse Pacemaker (Tahdistin), jos potilaalla on istutettava sydämentahdistin. 
zzzPAT tunnistaa automaattisesti segmentit, joissa PAT-pulssit vaikuttavat 
tahdistetuilta, esimerkiksi erittäin vähäiset sykkeen vaihtelut (lähellä tasaista), 
ja jättää ne pois analyysista. 
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Ahuomautus 

Tiettyjä tahdistintyyppejä ei saa käyttää WatchPAT-laitteen 
kanssa. Lisätietoja on laitteen käyttöoppaan vasta-aiheita 
käsittelevässä kohdassa. 

 Valitse Study with Tamper-Proof Testing (Tutkimus ja varmuustestaus), jos 
haluat käyttää potilasranneketta. Kun tämä vaihtoehto on otettu käyttöön, voit 
rannekkeen avulla varmistaa, että tunnistettu potilas todella nukkuu laitteen 
kanssa (katso WP-käyttöoppaan kohta Varmuustestaus). 

 Valitse Multiple Nights (Useita öitä), jos samaa WP-laitetta käytetään enintään 
3 yönä. 

 WP300: Run Device Test (Suorita laitetesti) -komento on esillä vain, kun laite 
on yhdistettynä. Kun tämä komento valitaan, yhdistetty laite testataan ja 
tulokset tulevat näkyviin erillisessä ikkunassa. Testin aikana tapahtuu sama 
Test Device (Testaa laite) -toiminto, joka suoritetaan erillislaitteesta käsin 
(katso WP-laitteen käyttöoppaan kohta Käyttäjän suorittamat testit. 

 WP300: Run device test while saving... (Suorita laitetesti tallennettaessa...) -
komento on esillä vain, kun laite on yhdistettynä. Kun tämä komento valitaan, 
yhdistetty laite testataan automaattisesti käyttäjän valitessa Save to WatchPAT 
(Tallenna WatchPAT-laitteeseen) -komennon ja tulokset tulevat näkyviin 
erillisessä ikkunassa. Testin aikana tapahtuu sama Test Device (Testaa laite) -
toiminto, joka suoritetaan erillislaitteesta käsin. 

 Rekisteröi tutkimus WP1-laitteeseen Switch to WP-ONE Device (Vaihda WP-
ONE-laitteeseen) -painikkeella. 

 Napsauta Save to WatchPAT (Tallenna WatchPAT-laitteeseen) -painiketta. 

 

Ahuomautus 

New Study (Uusi tutkimus) -valintaikkunassa käytetyt painon ja 
pituuden yksiköt määräytyvät tietokoneen alueasetusten 
perusteella. 

Jos WP-laitteessa on tietoja (yön aikainen tutkimus, jota ei ole ladattu zzzPAT-
tietokantaan, tai uuden potilaan tiedot, jotka on valmisteltu mutta joita ei ole käytetty 
tutkimuksessa), esiin tulee Data Not Loaded (Tietoja ei ladattu) -valintaikkuna. 

 Kun potilastiedot on tallennettu WP-laitteeseen, esiin tuleva viesti ilmoittaa, 
että tutkimuksen tallennus onnistui. 

Valitse Yes - (Kyllä -), jos haluat valmistella toisen tutkimuksen. 

Valitse No - (Ei -), jos haluat sulkea New Study (Uusi tutkimus) -valintaikkunan. 
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 Irrota USB-kaapeli laitteesta. 

 Uuden tutkimuksen valmisteleminen (WP1) 

 Varmista, että internetyhteys on aktiivisena. 

 Valitse zzzPAT-ohjelmistosta File>New Study Details (Tiedosto>Uuden 
tutkimuksen tiedot) tai napsauta työkalurivin New Study (Uusi tutkimus) -

kuvaketta . 

 Esiin tulee New Study (Uusi tutkimus) -valintaikkuna. 

 Täytä pakolliset kentät: Patient ID (Potilastunnus), Device SN (Laitteen 
sarjanumero) ja PIN. 

 Varmista, että esillä oleva sähköpostiosoite on oikein, jotta saat sähköposti-
ilmoituksia (sähköpostiosoite määritetään asennuksen aikana). 

 Lisää muita tietoja tarvittaessa. Muut kentät ovat vapaaehtoisia. 

 Valitse Multiple Nights (Useampi yö) -vaihtoehto, jos haluat käyttää samaa 
WP1-M-laitetta enintään kolmena yönä (tämä edellyttää anturin vaihtoa joka 
ilta). Tämä vaihtoehto näytetään vain, kun ominaisuus on otettu käyttöön 
kohteessa Error! Reference source not found.. Kun Multiple Nights 
(Useampi yö) -vaihtoehto valitaan, näkyviin tulevat valinnat 2 Nights (2 yötä) ja 
3 Nights (3 yötä). Oletusvalinta riippuu kohdassa General Options (Yleiset 
vaihtoehdot) tehdyistä määrityksistä. Näkyviin tulee myös uusia vaadittuja 
tekstikenttiä, joihin lisätään lisäanturien sarjanumerot (SN). 

 Rekisteröi laite ja anturit napsauttamalla Register WP-ONE (Rekisteröi WP-
ONE) -painiketta. Rekisteröinti epäonnistuu seuraavissa tapauksissa: 

o Jokin SN-numeroista puuttuu tai ei kelpaa. 

o Jokin SN-numeroista on jo rekisteröity. 

 Aloita tutkimus WP300- tai WP200(U ) -laitteella napsauttamalla Switch to WP 
Device (Vaihda WP-laitteeseen) -painiketta. 

 

Ahuomautus 

Jos sama WP1-laitteen sarjanumero on jo rekisteröity, esiin 
tuleva virheviesti kehottaa käyttäjää antamaan oikean / jonkin 
toisen sarjanumeron. 

Täytä tiedot oikein ja napsauta Register WP-ONE (Rekisteröi 
WP-ONE) -painiketta uudestaan. 
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New Study (Uusi tutkimus) -valintaikkunassa käytetyt painon ja 
pituuden yksiköt määräytyvät tietokoneen alueasetusten 
perusteella. 

 Kun potilastiedot on rekisteröity verkkopalvelimelle, esiin tuleva viesti ilmoittaa, 
että tutkimuksen tallennus onnistui: 

Valitse Yes - (Kyllä -), jos haluat valmistella toisen tutkimuksen. 

Valitse No - (Ei -), jos haluat sulkea New Study (Uusi tutkimus) -valintaikkunan. 

4.1.3 New Study (Uusi tutkimus) -näytön ominaisuudet 

Uuden tutkimuksen valmistelussa tarvittavien päänäytön kenttien lisäksi on ylimääräisiä 
kenttiä, joihin voi yksityiskohtaisesti kirjata potilaan aiemman ja nykyisen 
lääketieteellisen tilanteen. zzzPAT-ohjelmistossa voi lisäksi ladata potilastietoja 
aiemmista tutkimuksista. Näytön muilla ominaisuuksilla tutkimukset voi järjestellä 
haluamiinsa ryhmiin. 

Lisätietoja on kattavassa kuvitetussa oppaassa. 

4.2 Potilastutkimusten hallitseminen 

WP200(U)/WP300: Kun WP-unitutkimus on valmis, yhdistä WatchPAT-laite USB-
asemaan, avaa zzzPAT-sovellus ja valitse päävalikosta File>Load Study and Analyze 
(Tiedosto>Lataa tutkimus ja analysoi). Tallennetut digitaaliset tiedot latautuvat zzzPAT-
tietokantaan, ja järjestelmä analysoi ne automaattisesti. 

WP1: Kun WP-unitutkimus on valmis, avaa zzzPAT-sovellus ja valitse päävalikosta 
File>Load Study and Analyze (Tiedosto>Lataa tutkimus ja analysoi). Esiin avautuvassa 
ikkunassa on luettelo kaikista rekisteröidyistä potilaista, joiden tutkimusta ei vielä ole 
haettu verkkopalvelimelta. Kun valitset ladattavan tutkimuksen, valitun potilaan tallennetut 
tiedot latautuvat zzzPAT-tietokantaan. Järjestelmä analysoi tallennetut tiedot 
automaattisesti. Kun tutkimus on ladattu, käyttäjä voi tarkastella, muokata ja lisätä 
diagnostiikka- ja suositustietoja ja luoda uniraportin. Aiemmin ladattuja tutkimuksia voi 
avata ja tarkastella. 

 

Ahuomautus 

Rekisteröityjen WP1-laitteiden luettelossa on Status 
(Tila) -sarake seuraavilla vaihtoehdoilla: Ready 
(Valmis), Not started (Ei aloitettu) ja In process 
(Käynnissä). Voit päivittää kaikkien rekisteröityjen 
laitteiden tilan painamalla Check Status (Tarkista tila) 
-painiketta. 
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Ahuomautus 

Potilaita voidaan hakea Patient ID (Potilastunnus) -
tunnuksella ja laitteita Device SN (Laitteen 
sarjanumero) -numerolla. 

 

 

Ahuomautus 

Vaihda WP1-laitteen rekisteröityjen potilaiden 
luettelosta toiseen ja lataa tutkimus WP200(U)-
/WP300-laitteesta napsauttamalla Switch to 
WP200/300 Device (Vaihda WP200-/300-laitteeseen) 
-painiketta. 

4.2.1 Tiedosto>Uuden tutkimuksen tiedot  

Valmistelee WP-laitteessa olevan potilastiedoston unitutkimusta varten (kohta 4.1). 

4.2.2 Tiedosto>Lataa tutkimus ja analysoi  

Tällä komennolla lataat unitutkimuksen tiedot laitteesta ja tallennat ne zzzPAT-
tietokantaan. 

Tietoja ladattaessa esiin tulee viesti Loading Study (Tutkimusta ladataan). Se tarkoittaa, 
että tietoja siirretään WatchPAT-laitteesta kiintolevylle ja että potilastiedosto 
tallennetaan tietokantaan. 

Tässä vaiheessa järjestelmä tekee automaattisen analyysin ja tallentaa tulokset 
tietokantaan. Kun automaattinen analyysi on valmis, tulokset tulevat esiin näyttöön. 
Käyttäjä voi halutessaan tarkastella uniraporttia (Sleep report). 

WP200(U)/WP300: Kun usean yön tutkimusta ladataan, kaikkien öiden tutkimukset 
latautuvat automaattisesti ja viimeksi ladattu tutkimus avautuu näyttöön. Avaa ja 
tarkastele kaikkien öiden tutkimuksia avaamalla Open Study (Avaa tutkimus) -
valintaikkuna. 
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4.2.3 Tiedosto>Avaa tutkimus 

Avaa zzzPAT-tietokantaan tallennetut tutkimukset aiemmin ladatuista tutkimuksista. 
Kun kaksoisnapsautat potilasta, esiin tulee luettelo hänen tutkimuksistaan ja jokaisen 
tutkimuksen päiväys/aika. Lataa ja tarkastele tallennettuja tietoja näytössä 

kaksoisnapsauttamalla -tutkimuskuvaketta. 

Jos samassa tutkimuksessa on tehty useita analyyseja, esiin tulevassa valintaikkunassa 
käyttäjää kehotetaan valitsemaan avattava analyysi. 

Select Studies (Valitse tutkimukset) -painike 

Käyttäjä voi määrittää, valita ja organisoida Select Patient Study (Valitse 
potilastutkimus) -valintaikkunassa näkyviä tutkimuksia.  
Lisätietoja on kattavassa kuvitetussa oppaassa. 

4.2.4 Tiedosto>Tallenna tutkimustulokset 

Tallentaa tarkasteltavana olevat potilastutkimuksen tulokset (tapahtumat) sulkematta 
zzzPAT-ohjelmistoa ja määrittää tutkimuksen tarkastetuksi. Ominaisuutta tarvitaan, kun 
hengitystapahtumia muokataan (lisätään tai poistetaan) ja uusia tapahtumia on 
tallennettavia tulevia zzzPAT-istuntoja varten. 

4.2.5 Tiedosto>Tallenna uutena analyysina 

Tallentaa nykyisen analyysin sekä nykyiset tapahtumat ja signaalit uudeksi analyysiksi. 

4.2.6 Tiedosto > Sulje tutkimus  

Sulkee tarkasteltavana olevan potilastutkimuksen sulkematta zzzPAT-ohjelmistoa. 

4.2.7 Tiedosto>Sulje 

Sulkee sekä tarkasteltavan potilastutkimuksen että zzzPAT-ohjelmiston. 

4.2.8 Muokkaa>Tutkimuksen tiedot 

Avaa View>Study Details (Näytä>tutkimuksen tiedot) -valintaikkunan ja tuo esiin 
nykyisen potilaan tiedot. Tietoja voi muokata napsauttamalla Edit (Muokkaa) -
painiketta. Valtuutetut käyttäjät voivat muuttaa potilastunnusta vain kerran. 

4.2.9 Muokkaa>Kumoa 

Käyttäjä voi kumota edellisen toiminnon valitsemalla Undo (Kumoa) tai zzzPAT-

ohjelmiston työkaluriviltä . 

4.2.10 Muokkaa>Univaiheiden muokkaus hiirellä 

Kun toiminto  valitaan tai sitä napsautetaan, sen tila zzzPAT-ohjelmiston 
työkalurivillä vaihtuu niin, että käyttäjä voimuokata unen vaiheita ja CSR-aikoja hiirellä. 
Jos käyttäjä valitsee toiminnon ja siirtää hiiren kohdistimen unen vaihetta kuvaavan 
tapahtuman päälle (eli Light Sleep [Kevyt uni]), hiiren nuoli muuttuu käsikuvakkeeksi. 
Valittua tapahtumaa voi sen jälkeen vetää tai sen kokoa muuttaa. 
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4.2.11 Muokkaa>Kopioi… 

Kun signaaliosio on korostettuna, Copy (Kopioi) -ominaisuus on käytettävissä. Käyttäjä 
voi sillä kopioida halutut tiedot joko leikepöydälle kuvana tai tiedostoon 
binäärimuodossa. 

4.3 Näyttöruutu 

Päänäytössä näkyvät WP-laitteen tallentamat aaltomuodot sekä automaattisen analyysin 
havaitsemat tapahtumat. Käyrät näkyvät synkronoituina yhtenäiseen perusaikaan. 

Lisätietoja on kattavassa kuvitetussa oppaassa. 

4.3.1 Koko yön näkymä  ja tarkasteltavat kanavat 

Mitä tahansa valittua kanavaa voi tarkastella All Night Window (Koko yön näyttö) -
näkymässä, vaikka tutkimuksen kaikkien tarkasteltavien kanavien aikajakso muuttuisi. 

 Avaa koko yön näkymä valitsemalla View>All Night Window (Näytä>Koko 
yön näyttö) ja valitsemalla vaihtoehto All Night (Koko yö).  
Voit valita myös View>Channels (Näytä>Kanavat). 

 Valitse Visible (Näkyvissä) -kohdan vasemmalla puolella All Night (Koko yö) -
osassa oleva valintaruutu. 

 Valitse kanava, jota haluat All Night Window (Koko yön näyttö) -näkymässä 
tarkastella. 

Lisätietoja on kattavassa kuvitetussa oppaassa. 

4.3.2 Aktiivinen kanava 

Kanavan voi aktivoida napsauttamalla joko kanavaa tai sen otsikkoa (aktivoidun 
signaalin ja otsikoiden väri muuttuu). 

Kun kanavan otsikkoa napsautetaan hiiren kakkospainikkeella, kanava aktivoituu ja 
esiin tulee ponnahdusvalikko. 

4.3.3 Tilarivi  

 näytön alareunassa on seuraavat tiedot: 

 Tietokantayhteys (jaettu tai paikallinen) 

 Reaaliaikainen kello 

 Korostetun segmentin alkamisaika 

 Korostetun segmentin päättymisaika 

 Kesto 

 Aikatila (REL/ABS [SUHTEELLINEN/ABSOLUUTTINEN) 

4.4 Signaalin esitysvaihtoehdot 

4.4.1 Näytä>Määritä montaasin kanavat 

Montage (Montaasi) -näytössä on luettelo kaikista tarkasteltavista signaalikanavista: 



 

zzzPAT 5.2.80..X 18 zzzPAT-ohjelmiston käyttöopas 

 

 PAT – PAT-signaali. 

 Syke – johdettu PAT-signaalista. 

 PAT-amplitudi – PAT-signaalin taajuus. 

 SaO2 – valtimoveren happisaturaatiotaso. 

 Aktigrafi – aktigrafisignaali. 

 WP-laitteen tallentamat univaiheet – REM, kevyt uni, syvä uni ja hereillä olo. 

 Vartalon asento (lisävaruste) 

 Kuorsaus (lisävaruste) 

 Hengitysliikkeet (lisävaruste) 

Lisätietoja on kattavassa kuvitetussa oppaassa. 

4.5 Tutkimuksen tarkastelu, analysointi ja raportointi 

4.5.1 Tietojen analyysi 

zzzPAT-ohjelmisto analysoi WP-laitteen tallentamat signaalit automaattisesti. 
Analysoinnissa arvioidaan unen aikaisia hengityshäiriöitä, happisaturaatiota, sykettä ja 
unen eri vaiheiden tilastotietoja. Jos käytössä on SBP/RESBP-anturi, analyysissa 
saadaan myös kuorsauksen ja vartalon asennon tilastotietoja. 

 Analyysin luominen 

Järjestelmä analysoi tallennetut tutkimustiedot automaattisesti sen jälkeen, kun ne on 
ladattu laitteesta. Automaattisen tietojen analyysin voi käynnistää myös valitsemalla 
Analyze>Reload study and analyze (Analysoi>Lataa tutkimus uudestaan ja 
analysoi). 

Tämä toiminto lataa tallennetut tutkimustiedot uudestaan ja tekee automaattisen 
analyysin. Jos käyttäjä on muuttanut tiedostoa (lisännyt/poistanut/muokannut 
tapahtumia), muutokset häviävät eivätkä vaikuta analyysiin. 

Kun toimintoa käytetään tiedostossa, joka on aiemmin analysoitu ja tallennettu 
zzzPAT-ohjelmiston vanhemmalla versiolla, se tekee uuden analyysin zzzPAT-
ohjelmiston nykyisellä versiolla. 

REM-analyysi on osa automaattista analyysia edellä kuvatun mukaisesti. 

Tietyissä tilanteissa järjestelmä ei REM-analyysilla pysty aukottomasti määrittämään 
REM-unijaksoja tallennetuista signaaleista. 

Kun näin käy, näkyvissä ovat vain unen ja valveilla olon vaiheet. Raportissa REM-
jakson ja univaiheiden tilastotietokohdat ovat poissa käytöstä. Niiden tilalla lukee 
Inconclusive REM Detection (REM-jaksoja ei voitu luotettavasti havaita). 

4.5.2 Tapahtumien hallitseminen 

Automaattisen analyysin merkitsemät tapahtumat näkyvät värillisissä laatikoissa. Kun 
hiiren kohdistin viedään tapahtuman päälle, esiin tulevassa työkaluvihjeessä näkyvät 
seuraavat tiedot: 
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 Tapahtuman nimi 

 Tapahtuman muodostaja (esimerkiksi automaattinen analyysi tai käyttäjä) 

 Alkamisaika 

 Kesto 

 

Lisätietoja on kattavassa kuvitetussa oppaassa. 

4.6 Raportit 

Kaikkia raportteja voi tarkastella näytössä ja tulostaa. 

Raportin tarkastelutilassa työkalurivillä ovat seuraavat toiminnot: 

 Tulosta raportti napsauttamalla Print (Tulosta) -painiketta. 

 Vie raportti toiseen tiedostomuotoon, esimerkiksi pdf, rtf tai html, 
napsauttamalla Export (Vie) -painiketta. 

 Käyttäjä näkee, kuinka monta sivua raportissa on,  ja voi valita tarkasteltavan 

sivun -kuvakkeilla. 

Lisätietoja on kattavassa kuvitetussa oppaassa. 

4.6.1 Raportti>Kliininen diagnoosi 

Tämän ominaisuuden avulla Sleep Report (Uniraportti) -näyttöön voidaan lisätä 
diagnoosi ja suosituksia. Tähän näyttöön lisätyt tiedot näkyvät uniraportin 
ensimmäisellä sivulla. 

 Voit allekirjoittaa raportin kirjoittamalla nimesi tai valitsemalla sen 
valikkopalkista. 

 Valitse Set as Reported (Merkitse raportoiduksi) -valintaruutu, joka osoittaa 
nykyisen tutkimuksen analyysin olevan lopullinen ja että uniraportti on 
kyseessä olevan analyysin lopullinen raportti. 

 Valitse No AHI Central Statistics (Ei keskeisiä AHI-tilastoja) -valintaruutu, jos 
haluat jättää keskeiset apneatilastot pois raportista. 

 Valitse Send to HL7 (Lähetä HL7:ään) -valintaruutu kyseessä olevan 
tutkimuksen lähettämiseksi HL7:ään, kun HL7-palvelu on asennettuna ja 
käytössä. Huomaa, että valintaruutu on valittava kunkin HL7:ään lähetettävän 
tutkimuksen kohdalla. 

4.6.2 Raportti>Uniraportti 

Uniraportti on yksi-, kaksi-, neljä- tai viisisivuinen raportti, jossa annetaan asetusten 
mukainen yhteenveto potilaan unitutkimuksesta. 

Raportin ensimmäisellä sivulla on seuraavat osat: Patient Information (Potilastiedot), 
Sleep Study Information (Unitutkimuksen tiedot), Referring Physician (Lähettävä 
lääkäri), Medical history (Sairauskertomus), Diagnosis (Diagnoosi) ja 
Recommendations (Suositukset). 
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Toisella sivulla ovat tutkimuksen tulokset: unitietojen yhteenveto, PAT-
hengityshäiriöindeksi (pRDI), PAT-apnea-hypopneaindeksi (pAHI), apnea-hypopnean 
PAT-keski-indeksi (pAHIc)*, tapahtumien lukumäärä, prosenttiosuus kokonaisuniajasta 
Cheyne-Stokesin hengityskaavalla (%CSR)*, happisaturaation tilastotiedot, kuten 
happidesaturaatioindeksi (ODI), happisaturaatiotasojen keskiarvot sekä vähimmäis- ja 
enimmäisarvot, happisaturaatioanalyysi, sykkeen tilastotiedot, REM-unianalyysi ja 
AHI-vakavuustasokaavio. 

Kolmannella sivulla esitetään graafisessa muodossa hengitystapahtumat, 
kuorsauksen ja vartalon asennon kaavio (jos vastaavaa anturia on käytetty), 
happisaturaatio, syke, PAT-amplitudi, unen eri vaiheet (hereillä / kevyt uni / syvä uni ja 
REM). 

Neljännellä sivulla esitetään ympyräkaavioina hereillä ja unessa olo, unen eri vaiheet, 
nukahtamisviive, REM-unen viive, yöllisten heräämisten määrä sekä unen 
tehokkuuden, kuorsauksen ja vartalon asennon tilastotiedot (jos vastaava anturi on 
ollut käytössä). 

Error! Reference source not found. on valinnainen sivu, jota ei tulosteta 
oletusarvoisesti. Jos haluat tulostaa tämän sivun, valitse Oximetry and Pulse Rate 
Histogram Page in Sleep Report (Oksimetrian ja pulssin histogrammisivu 
uniraportissa) -valintaruutu kohdassa General Settings (Yleiset asetukset) (katso osio 
Error! Reference source not found.). Sivulla näytetään seuraavat oksimetria- ja 
pulssihistogrammit: 

 Happisaturaatiojakauma: sekuntien määrä kutakin happisaturaatioarvoa 
kohden. 

 Desaturaatiotapahtumien määrä kutakin happisaturaation resaturaatiohuippua 
kohden. 

 Desaturaatiotapahtumien määrä kutakin desaturaatiopohjalukemaa kohden. 

 Desaturaatiotapahtumien määrä kutakin desaturaatiotapahtuman 
vähimmäislukemaa (nadir) kohden. 

 Pulssijakauma: sekuntien määrä kutakin pulssiarvoa kohden. 

Histogrammit ovat tyhjiä, jos kelpoista uniaikaa ei ole kertynyt lainkaan. 

*pAHIc- ja %CSR -tiedot ovat mukana raportissa, jos RESBP-anturia on käytetty. pAHIc- ja 
%CSR-arvot käyvät ilmi raportista, mikäli sääntelyviranomaiset ovat ne kyseisessä maassa 
hyväksyneet. 

Määritelmät: 

Uniaika: Kokonaisaika tunteina, jonka potilas on ollut unessa. 
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PAT-hengityshäiriöindeksi (pRDI): hengitystapahtumien arvioitu määrä jaettuna 
kelvollisella uniajalla. Tulos esitetään raportissa hengitystapahtumina tunnissa. Indeksi 
lasketaan koko yön kelvollisesta uniajasta (REM ja muu kuin REM). 

PAT-apnea-hypopneaindeksi (pAHI): apnea- ja hypopneatapahtumien arvioitu 
määrä jaettuna kelvollisella uniajalla. Tulos esitetään raportissa apnea- ja 
hypopneatapahtumien määränä tunnissa. Indeksi lasketaan koko yön kelvollisesta 
uniajasta (REM ja muu kuin REM). 

Apnea-hypopnean PAT-keski-indeksi (pAHIc): sentraalisten apneatapahtumien ja 
hypopneatapahtumien arvioitu määrä jaettuna kelvollisella uniajalla. Tulos esitetään 
raportissa sentraalisten apneatapahtumien ja hypopneatapahtumien määränä 
tunnissa. 

Prosenttiosuus kokonaisuniajasta Cheyne-Stokesin hengityskaavalla (%CSR): 
CSR-kaavan arvioitu prosenttiosuus kelvollisesta uniajasta*. 

*pAHIc- ja %CSR -arvoissa käytetty kelvollinen uniaika saattaa poiketa muiden indeksien 
laskemisessa käytetystä kelvollisesta uniajasta, koska RESBP-anturin on oltava kelvollinen 
myös tässä laskelmassa. 

Happidesaturaatioindeksi (ODI): happidesaturaatiotapahtumien määrä (määritetty 
vähimmäisdesaturaatioarvo, 3 tai 4 %) jaettuna kelvollisella uniajalla. Tulos esitetään 
raportissa desaturaatiotapahtumina tunnissa. Indeksi lasketaan koko yön kelvollisesta 
uniajasta (REM ja muu kuin REM). 

REM, prosenttiosuus uniajasta: REM-univaiheiden prosenttiosuus 
kokonaisuniajasta. 

Kuorsaustaso desibeleinä: Koska kuorsaaminen voi olla merkki uniapneasta, 
zzzPAT-ohjelmisto tuottaa tilastotietoja kuorsaamisesta. Kynnysarvo määritetään 
desibeleinä. Kuorsaamisen määrää arvioidessa lasketaan, kuinka suuri prosenttiosuus 
uniajasta ylittää desibeleinä määritetyn kynnysarvon. Kuorsauksen 
äänenvoimakkuustaso näkyy graafisena esityksenä (välillä 40–70 dB). 

Vartalon asento: Viisi vartalon asentoa näkyy graafisessa muodossa: selällään, 
vatsallaan, vasemmalla tai oikealla kyljellä, istuen. Koska apneatapahtumien taajuus 
unen aikana määräytyy potilaan asennon ja univaiheen mukaan, zzzPAT-ohjelmisto 
ilmoittaa, kuinka kauan potilas nukkui kussakin asennossa: selällään, vatsallaan, 
vasemmalla tai oikealla kyljellä, istuen. Ohjelmisto esittää kaaviona kussakin 
asennossa vietetyn uniajan prosenttiosuudet. Lisäksi raportissa ovat mukana 
tallentuneet tapahtumat, kuten hengityshäiriöindeksi (pRDI), apnea-hypopneaindeksi 
(pAHI) ja desaturaatioindeksi (ODI), jokaisessa vartalon asennossa (myös muissa 
asennoissa kuin selinmakuulla). 
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AHI-vakavuustasokaavio:  Ilmoittaa obstruktiivisen uniapnean vakavuustason. 
Yhdysvaltalainen unitutkimusjärjestö American Academy of Sleep Medicine (AASM) 
luokittelee apnean seuraaviin tasoihin: lievä (5–15 tapahtumaa tunnissa), keskivaikea 
(15–30 tapahtumaa tunnissa) ja vaikea (>30 tapahtumaa tunnissa). Vakavuustasojen 
raja-arvoja voi muokata kohdassa Setup>General Settings>Analysis/Statistics 
Parameters (Asetukset>Yleiset asetukset>Analyysin/tilastotietojen parametrit). 

4.6.3 Raportti>Uniraportti valitulta aikajaksolta 

Tämä toiminto luo kaksisivuisen yhteenvetoraportin tutkittavan unitutkimuksesta 
käyttäjän valitsemalta aikajaksolta (Selected Time Range). 

Luo raportti valitulta aikajaksolta seuraavalla tavalla: 

 Korosta aaltomuodon haluttu osa signaalien näyttöikkunassa napsauttamalla ja 
hiirellä vetämällä. 

 Valitse Report>Sleep Report for Selected Time Range (Raportti>Uniraportti 
valitulta aikajaksolta). 

Lisätietoja on kattavassa kuvitetussa oppaassa. 

4.6.4 Raportti>Tapahtumaraportti 

Raportissa on tilastotiedot zzzPAT-ohjelmiston automaattisen analyysin ja käyttäjän 
havaitsemista erityyppisistä tapahtumista. Graafisesta esityksestä näkee nopeasti 
tapahtumien jakauman, ja yhteenvetokohdassa on tilastotietoja. Kun tapahtuma näkyy 
ruudussa, käyttäjä voi avata tarkan luettelon kaikista tietyn tyyppisistä tapahtumista 
kaksoisnapsauttamalla tiettyä tapahtuman nimeä (halutulla rivillä kaavion alapuolella). 

4.6.5 Raportti>Uni-indeksit 

Tässä raportissa on yhteenveto tutkimustuloksista, muun muassa pRDI, pAHI, ODI ja 
uniaika. 

4.6.6 Raportti>Potilaan seurantaraportti 

Tässä raportissa voi vertailla saman potilaan useita tutkimuksia. Tutkimusten välisiä 
trendejä on helppo havaita, sillä arvot pRDI, pAHI ja ODI esitetään graafisessa 
muodossa. 

Näkyvissä on myös unen prosenttiosuus (Sleep %), jolloin kuorsauksen desibeleinä 
määritetty kynnysarvo ylittyy. 

4.6.7 Raportti>Potilasraportti 

Tämä raportti on kirjemuodossa potilaalle laadittu esitys, jossa kerrotaan unitutkimuksen 
tuloksista. Se sisältää seuraavat potilastiedot: 

 Kokonaisuniaika 

 Apnea-hypopneaindeksi (AHI) 

 Hengityshäiriöindeksi (RDI) 

 Desaturaatioindeksi (ODI) 
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 Vilkeuni (REM) 

Se myös vertaa saatuja arvoja tavanomaisiin indeksikeskiarvoihin. 

 

Ahuomautus 

zzzPAT-asennuksen yhteydessä asennetaan kolme eri 
patientletter.ini-tiedostoa: yksi miehille, yksi naisille ja yksi 
oletustiedosto. Jos potilaan sukupuoli on määritetty, 
potilasraportin laadinnan yhteydessä näytetään kyseinen malli, 
jos käytössä oleva kieli erottelee eri sukupuolet. Jos potilaan 
sukupuolta ei ole määritetty, näytetään mieheen viittaava malli. 

Luo potilaalle tarkoitettu raportti seuraavalla tavalla: 

1. Valitse Report (Raportti) -valikosta Report for Patient (Potilasraportti). 

2. Tulosta raportti napsauttamalla tulostinkuvaketta. 

4.6.8 Raportti > Yksityiskohtainen raportti 

Tämän raportin ensimmäinen sivu on sama kuin uniraportin. Muilta raportin sivuilta 
löytyy graafisia esityksiä hengitystapahtumista, kuorsaamisesta ja vartalon asennosta 
kertova kaavio (kun testissä käytettiin kuorsausta ja vartalon asentoa mittaavaa anturia), 
happisaturaatio, pulssi, PAT-amplitudi ja tietoa hereillä olosta / kevyestä unesta / 
syvästä unesta sekä REM-vaiheista. Kukin sivu edustaa yhtä unituntia. 

4.6.9 Raportti > Useamman yön yhteenvetoraportti 

Tässä yhteenvetoraportissa esitetään useamman yön unitilastot. Raportti on 
käytettävissä vain, kun avoinna oleva tutkimus sisältää useamman yön WP1-tietoja 
(katso osiosta Error! Reference source not found. tietoa uuden WP1-tutkimuksen 
suorittamisesta useamman yön ominaisuutta käyttäen). Raporttiin sisältyy enintään 
kolme tutkimusta (yksi kutakin saraketta kohden). Kunkin tutkimuksen WP1-laitetta ja 
potilasta koskevat tiedot ovat samat. Raportissa on lisäksi sarake, jossa näytetään 
tutkimuksen arvojen keskiarvot (katso alta). 

4.6.10 Tulostaminen 

WP-laitteen tallentamat ja zzzPAT-ohjelmiston analysoimat tutkimussignaalit voi 
tulostaa seuraavilla tavoilla: 

Napsauta työkalurivin tulostuskuvaketta  tai valitse File>Print (Tiedosto>Tulosta). 

Käyttäjällä on useita eri tulostusvaihtoehtoja: 

 Koko tutkimus 

 Näyttö 

 Tietyt osat aikajakson mukaan 

 Tietyt kanavat 
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5 Tietojen vieminen 
Lisätietoja on kattavassa kuvitetussa oppaassa. 
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6 Työkalut 

Lisätietoja on kattavassa kuvitetussa oppaassa. 
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7 Tietokannan ohjattu asennustoiminto 
Lisätietoja on kattavassa kuvitetussa oppaassa. 
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8 Vianmääritys 

Asentaminen 
Ongelma Mahdollinen syy Ratkaisu 

zzzPAT-
asennustiedosto ei 
käynnisty. 

Automaattista 
käynnistymistoimintoa ei 
ole aktivoitu 
Windowsissa. 

Siirry hakemistoon My 
Computer>zzzPAT CD ja 
kaksoisnapsauta tiedostoa Setup.exe. 

Windows-versio ei ole 
yhteensopiva zzzPAT-
ohjelmiston kanssa. 
 

Käytä tietokonetta, jonka 
käyttöjärjestelmä on yhteensopiva. 

Laitteistokokoonpano ei 
täytä 
vähimmäisvaatimuksia. 

zzzPAT-asennustiedosto tarvitsee 
vähintään 128 megatavua RAM-muistia 
ja Pentium-prosessorin. 

zzzPAT ei tunnista 
WatchPAT-
ohjelmistoa 
(vain WP200) 

USB-asema on 
määritettävä uudestaan. 

Valitse Setup>Set WatchPAT Drive 
(Asetukset>Määritä WatchPAT-asema). 
Aseta WatchPAT-laite USB-asemaan. 
Valitse OK. 
Esiin pitäisi tulla viesti The system is 
searching for WatchPAT device 
(Järjestelmä etsii WatchPAT-laitetta). 
Lopuksi esiin pitäisi tulla luettelo, jossa 
WP200-asema on mukana. 
Valitse ensin WatchPAT-asema ja sitten 
OK. 

Windows XP -
käyttöjärjestelmässä 
käyttäjä ei voi ladata 
tutkimusta tai käyttää 
tietokannan ohjatun 
asennustoiminnon 
apuohjelmia, vaikka 
hänellä olisi 
asianmukaiset 
zzzPAT-
käyttöoikeudet. 

Käyttäjällä ei ole 
kirjoitusoikeuksia 
asemiin, joissa 
sovellukset sijaitsevat.  

Tarkista käyttäjän osiokohtaiset 
kirjoitusoikeudet ja määritä uudelleen 
tarpeen mukaan.  

Taulukko 1 – Vianmääritys, asentaminen 

zzzPAT 
Ongelma Mahdollinen syy Ratkaisu 

zzzPAT-ikkunan 
Analyze>Reload 
Study and Analyze 
(Analysoi>Lataa 

Käyttäjällä ei ole 
oikeuksia tämän 
apuohjelman 
käyttämiseen. 

zzzPAT-järjestelmänvalvoja voi muokata 
käyttäjän laajennettuja käyttöoikeuksia.  
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tutkimus uudestaan 
ja analysoi) -
komento ei ole 
käytössä 

Kiintolevyllä ei ole 
riittävästi vapaata tilaa 

Vapauta riittävästi levytilaa 
(vähimmäisvaatimus 100 Mt) ja yritä 
uudestaan 

Load Study (Lataa 
tutkimus) -komento 
ei ole käytössä 

Vapaata levytilaa on alle 
200 Mt 

Vapauta riittävästi levytilaa 
(vähimmäisvaatimus 200 Mt) ja yritä 
uudestaan 

zzzPAT ei käynnisty 
tai toimii 
arvaamattomasti 

Jotkin zzzPAT-tiedostot 
ovat ehkä vioittuneet tai 
ne on ylikirjoitettu 

Poista zzzPAT-ohjelmiston asennus ja 
asenna se uudestaan.  

Avatussa 
tiedostossa ei näy 
REM-unen tietoja  

Tiedosto on tallennettu 
zzzPAT-ohjelmiston 
vanhemmalla versiolla, 
jossa ei ollut REM-
ominaisuuksia tai REM-
unen tietoja ei voitu 
laskea algoritmin 
rajoitusten takia. 

Aja analyysi valitsemalla 
Analyze>Reload Study and Analyze 
(Analysoi>Lataa tutkimus uudestaan ja 
analysoi) 

Uniraporttia ei voi 
luoda, Sleep Report 
(Uniraportti) -painike 
näkyy harmaana 

Vapaata levytilaa on alle 
100 Mt 

Vapauta riittävästi levytilaa 
(vähimmäisvaatimus 100 Mt) ja yritä 
uudestaan 

Tutkimuksia ei ole 
ladattu tai tutkimus ei 
kelpaa 

Avaa haluttu tutkimus. Jos tutkimus on jo 
avattu, siinä saattaa olla viallisia tietoja, 
joita ei voi käyttää 

Käyttäjä ei voi 
kirjautua zzzPAT-
ohjelmistoon 

zzzPAT ei avaudu, jos 
toisella käyttäjällä on 
auki toinen istunto 

Varmista, että kukaan muu käyttäjä ei ole 
jättänyt tietokoneelle auki zzzPAT-
istuntoa. Jos varmentaminen ei onnistu, 
käynnistä tietokone uudestaan 

Käyttäjää ei ole 
määritetty zzzPAT-
ohjelmistossa 

zzzPAT-järjestelmänvalvojan on 
määritettävä käyttäjä 

Raportin 
lähettäminen 
sähköpostitse 
epäonnistuu 

Microsoft Outlookia ei 
ole määritetty 
oletusarvoiseksi 
sähköpostiohjelmaksi. 

Määritä Microsoft Outlook (tai Outlook 
Express) oletusarvoiseksi 
sähköpostiohjelmaksi 

Tapahtumien nimiin 
tehdyt muutokset 
eivät näy näytössä 

Tapahtumien nimet 
tallentuvat analyysin 
mukana. Muutokset 
näkyvät vasta, kun 
analyysi on ajettu 
uudestaan 

Aja analyysi valitsemalla 
Analyze>Reload Study and Analyze 
(Analysoi>Lataa tutkimus uudestaan ja 
analysoi) 

Tulostettaessa 
esiintyy virheitä 

Tulostinohjain ei ole 
yhteensopiva 

Postscript-tulostinohjain toimii 
luotettavimmin zzzPAT-ohjelmiston 
kanssa. Asenna käytettävään tulostimeen 
sopiva postscript-tulostinohjain ja yritä 
uudestaan. 
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Kun valitset 
zzzPAT-
ohjelmistosta New 
Study (Uusi 
tutkimus), 
valintaikkuna katoaa 
ja zzzPAT jäätyy 

Jos New Patient (Uusi 
potilas) -painiketta 
kaksoisnapsautetaan 
vahingossa, 
valintaikkuna saattaa 
olla piilossa taustalla 

Tuo valintaikkuna takaisin etualalle 
näppäimillä Alt+Tab 

New Study (Uusi 
tutkimus) -
valintaikkunassa ei 
ole Enable multi-
night option (Ota 
käyttöön usean yön 
vaihtoehto) -
asetusta 

WP-laitteen 
ohjelmistoversio on 
vanhempi kuin 2.2182 

Päivitä WP-laitteeseen uusin 
ohjelmistoversio (pyydä päivitystä Itamar-
käyttäjätuesta) 

New Study (Uusi 
tutkimus) -
valintaikkunassa ei 
ole Enable tamper-
proof testing (Ota 
käyttöön 
varmuustestaus) -
asetusta 

WP-laitteen 
ohjelmistoversio on 
vanhempi kuin 2.2182 

Päivitä WP-laitteeseen uusin 
ohjelmistoversio (pyydä päivitystä Itamar-
käyttäjätuesta) 

Kuorsaukseen ja 
vartalon asentoon 
liittyviä tietoja ei näy  

SBP/RESBP-anturia ei 
ole yhdistetty WP-
laitteeseen 

Varmista, että SBP on yhdistetty WP-
laitteeseen. 
Varmista, että RESBP on yhdistetty vain 
WP200U- tai WP300-laitteeseen 

 RESBP-anturi on 
yhdistetty WP200-
laitteeseen 
WP200U/WP300-laitteen 
sijasta 

Varmista, että RESBP on yhdistetty vain 
WP200U- tai WP300-laitteeseen 

 Ohjelmistoversio ei ole 
yhteensopiva 

WP200U-laitteen RESBP-anturi: 
Varmista, että käytössä on vähintään 
ohjelmistoversio 3.3228 

Hengitysliikkeisiin 
liittyviä tietoja ei näy 

RESBP-anturia ei ole 
yhdistetty WP300- tai 
WP200U-laitteeseen 

Varmista, että RESBP on yhdistetty vain 
WP200U- tai WP300-laitteeseen 

Oksimetrialukema ei 
kelpaa (oksimetria-
arvo on 127 %) 

Signaali ei riitä anturin 
toimintahäiriön / liikkeen 
aikana tallennetun 
lukeman / heikon tai 
vaihtelevan signaalin 
voimakkuuden takia 

Jos oksimetrialukema on kelvoton 
parhaissakin olosuhteissa, vaihda uPAT-
anturi. Jos lukema on yhä kelvoton, 
vaihda uPAT-kaapeli tai ota yhteyttä 
Itamar Medical -tukeen. 
 

Taulukko 2 – Vianmääritys, zzzPAT 
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Jaettu käyttötila zzzPAT-ohjelmistossa 
Ongelma Mahdollinen syy Ratkaisu 

Käyttäjä ei voi 
kirjautua zzzPAT-
ohjelmistoon 

Jaetussa käyttötilassa 
käyttäjä on ehkä 
määritetty jaettuun 
tietokantaan mutta ei 
paikalliseen tai toisin 
päin. 

Määritä käyttäjä toiseen tietokantaan tai 
poistu zzzPATista ja kirjaudu sisään 
toiseen zzzPAT-tietokantaan (paikalliseen 
tai jaettuun) 

Tallennettua 
tiedostoa ei löydy 

Tiedosto on tallennettu 
toiseen tietokantaan 
(joko paikalliseen tai 
jaettuun) 

 Varmista, kumpaan tietokantaan 
zzzPAT on yhdistetty 
(tietokantayhteys näkyy zzzPAT-
ohjelmiston tilarivillä) 

 Sulje zzzPAT 
 Käynnistä zzzPAT ja muodosta 

yhteys toiseen tietokantaan 
 Valitse File>Open 

(Tiedosto>Avaa) ja etsi haluttu 
tiedosto 

Jaettu tietokanta ei 
ole käytettävissä 

Verkkoyhteys on poikki  Varmista, että zzzPAT-asemasta 
on asianmukainen verkkoyhteys ja 
että siitä on pääsy 
verkkopalveluihin. Kysy 
tarvittaessa neuvoa 
järjestelmänvalvojalta 

Valittua tutkimusta 
ei voi avata 

Tutkimus on toisen 
zzzPAT-käyttäjän 
käytössä 

 Odota, kunnes toinen käyttäjä 
sulkee tutkimuksen, ja yritä 
uudestaan 

Taulukko 3 – Vianmääritys, jaettu käyttötila zzzPAT-ohjelmistossa 
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Apuohjelmat 
Ongelma Mahdollinen syy Ratkaisu 

Uuden tutkimuksen 
valmistelu epäonnistui 

Laite irrotettiin USB-
asemasta liian 
nopeasti. 

Älä poista laitetta, ennen kuin esiin 
tulee tutkimuksen tallentamisen 
onnistumisesta kertova valintaikkuna 

Vain WP200(U): Uusi 
tutkimus tai zzzPAT ei 
tunnista WP200(U)-laitetta 

Aseman nimi on 
poistettu 

Alusta asema nimellä WP200 

Vain WP300: Uusi 
tutkimus tai zzzPAT ei 
tunnista WP300-laitetta 

FTDI-ohjaimia ei ole 
asennettu kunnolla 

Varmista, että FT4222H-liittymät A, 
B, C ja D näkyvät laitehallinnan 
kohdassa Universal Serial Bus 
controllers (Sarjaväylän ohjaimet) -
kohdassa, kun WP300 yhdistetään 
USB-liitäntään. Jos liittymiä ei näy, 
ota yhteyttä Itamar Medical -tukeen 

Database Tools 
(Tietokantatyökalut) -
painike tietokannan 
ohjatun asennustoiminnon 
ikkunassa tai zzzPAT-
ohjelmiston Tools 
(Työkalut) -kohdassa ei 
ole käytössä 

Käyttäjällä ei ole 
oikeuksia tämän 
apuohjelman 
käyttämiseen 

zzzPAT-järjestelmänvalvoja voi 
muokata käyttäjän laajennettuja 
käyttöoikeuksia 

User Administration 
(Käyttäjähallinta) -painike 
tietokannan ohjatun 
asennustoiminnon 
ikkunassa tai Tools>User 
Administration 
(Työkalut>Käyttäjähallinta) 
-kohdassa ei ole käytössä 

Käyttäjällä ei ole 
oikeuksia tämän 
apuohjelman 
käyttämiseen 

zzzPAT-järjestelmänvalvoja voi 
muokata käyttäjän laajennettuja 
käyttöoikeuksia  

Tietokantatyökalut eivät 
avaudu 

zzzPAT tai uusi 
tutkimus on käynnissä 

Sulje zzzPAT tai uusi tutkimus ja 
avaa tietokantatyökalut 

Pääkäyttäjä on unohtanut 
salasanansa 

- Ota yhteyttä Itamar Medical -
edustajaan 

Taulukko 4 – Vianmääritys, apuohjelmat 
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Liite A: KÄYTTÖOIKEUSSOPIMUS 

Tämä käyttöoikeussopimus muodostaa käyttäjän ja Itamar Medical -yhtiön välille täydellisen 
ja yksinomaisen sopimuksen. Asiakirja on tarkasteltavissa osoitteessa 
https://www.itamar-medical.com/lmages/licensewp.pdf 

Jos sinulla on kysyttävää tästä käyttöoikeussopimuksesta tai haluat ottaa Itamar Medical -
yhtiöön yhteyttä muussa tarkoituksessa, voit kirjoittaa meille seuraavaan osoitteeseen. 

Yhdysvallat: 
Itamar Medical Inc. 
3290 Cumberland Club Drive, Suite 100 
Atlanta, Georgia 30339, Yhdysvallat 
Puh.: 1 888 748 2627 

Muut maat: 
Itamar Medical Ltd. 
9 Halamish Street, PO 3579 
Caesarea 3088900, Israel 
Puh.: +972 4 617 7000 
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Liite B: Sääntelyviranomaisen edustaja 

Itamar Medicalin valtuutettu sääntelyviranomaisen edustaja: 
 

Arazy Group GmbH 
 
The Squaire 12, Am Flughafen, 
60549 Frankfurt am Main, Saksa 
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Liite C: NAF-kanavan (lämpöilmavirta-anturi) 
käyttöönotto 

zzzPAT tukee NAF (Nasal Air Flow eli ilmavirtaus nenästä) -signaalia kanavanäkymässä, 
kun tutkimuksessa käytetään NAF-lisävarustetta. 

NAF-kanavan käyttöönotto 
1. Avaa/lataa tutkimus, jossa käytettiin NAF-lisävarustetta. 
2. Valitse kohdasta View (Näytä) valinta Define Channels in Montage 

(Määritä kanavat montaasissa). 

 
 

3. Vasemmanpuoleisessa luettelossa (All Channels [Kaikki kanavat]) 
näytetään vaihtoehdot NAF ja NAF Filtered (NAF, suodatetut) (NAF-
kanava, jonka suodatin vähentää signaalin kohinaa). 
Valitse NAF, napsauta Add (Lisää) ja valitse sitten OK. 

 
4. Valitse Setup (Määritykset) -kohdasta valinta User settings 

(Käyttäjäasetukset) ja avaa Manage Montage (Montaasin hallinta) -välilehti. 
Valitse Save as (Tallenna nimellä) ja nimeä uusi montaasi, johon on lisätty 
NAF-kanava. 
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5. Uusi montaasi lisätään montaasiluetteloon, kun tallennus on valmis. 
6. Valitse Set as Default (Aseta oletukseksi) ja sitten OK. 
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Liite D: Hakemisto 

A 

Analysoi>Lataa tutkimus uudestaan ja analysoi 
· 18 

Asetukset>Asetukset · 10 
Asetukset>Hakemistot · 10 

D 

Database Wizard · 11 
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Käyttäjähallinta · 31 
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Muokkaa>Kopioi · 16, 17 
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Näytä>Kanavat · 17 
Näytä>Koko yön näyttö · 17 
Näytä>Tutkimuksen tiedot · 16 
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ODI · 20, 21, 22 
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pREM · 21 
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Raportti · 19 
Potilaan seurantaraportti · 22 
Tapahtumaraportti · 22 
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Tapahtumien Hallitseminen · 18 
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Tiedosto>Avaa tutkimus · 16 
Tiedosto>Lataa tutkimus ja analysoi · 15 
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15 
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